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SUBJECT: NEO CONSOLE SOFTWARE VERSION 3 BUILD 43 RELEASE SERIES: NEO Consoles
DISTRIBUTION: General Release STATUS: Routine
Introduction

NEO Console Software Version 3 Build 43
Philips Strand Lighting has released a new version of software for the NEO lighting control
console. This software, Version 3 Build 43, is available for immediate download from the Support
section of the Philips Strand Lighting web site at www.strandlighting.com.
This version of software not only resolves reported issues but advances the console with
additional features.

Note:  This bulletin is for information purposes only. Users and owners are not required to inspect
or load this version of software in their NEO consoles unless they wish to have these added
improvements and features. Before updating console software, Philips Strand Lighting
recommends users make a backup of all current show files. For installation and upgrade
instructions, see “Appendix A” on page 9 of this bulletin.

Version 3 Build 43 Release Summary
Below is a description of some of the improvements and history of changes in of this software. All
information, features, and software updates are included in the current release - Version 3 Build
43.

Version 3 Build 43:
• Adds updated and released user’s manual.

Note:  The user’s manual is available for download on the Strand Lighting web site.

Version 3 Build 42:
• Resolves and issue reported with Philips Advantage DMX.

Version 3 Build 40:
• Resolves an issue with macros not running if network is not detected.
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Version 3 Build 39:
• Added QuickStart Guide to Options menu.

Note:  The QuickStart Guide is available for download on the Strand Lighting web site.

Version 3 Build 38:
• Fixed network startup problem.
• Philips Advantage DMX was stopping fixtures going back to state on a restart.
• Added remote viewer. This can be run from the control panel or on your laptop it should be 

the start menu.
a. Once connected to a remote system you will see a small down pointing arrow in the 

top right of the window. This is how you access options like full screen etc.
b. At the moment the remote viewing server is defaulted off. You need to turn it on in 

the system properties in the same place as the telnet settings.

Version 3 Build 36:
• Software installation allows for fixture library replacement (creates backup first.)

Version 3 Build 35:
• Fixed control panel XML file to show the correct version number for the fixture editor.
• Fixed the "The fixture XXXX is stored in this show file but is different to the one found in 

the default fixture library". Pressing "Keep ALL console fixtures" was doing the opposite of 
what it should have.

• Fixed - VL4000 Spot. There is no need for the last Edge 4 wheel group. I would put Shutter 
Rotation on the page Iris, Zoom and Focus.

• Fixed - VL4000 Spot. Prism Rotate does not display correctly. When Prism is at 5% Rotate 
Normal, Prism Rotate still shows to be in Index mode.

• Added an option when doing an update to "Replace" the fixture library with the one in the 
install (rather than merging). The old library is copied to a backup location.

Version 3 Build 32:
• The first wheel shortcut should clear the parameter. Instead of the first item being Color/

Gobo 1, should be Color/Gobo 0. 
• If the shortcut page is open and you select a fixture, it changes pages. Great. But if you select 

the fixture THEN you open the shortcut page, you have to manually select the correct page.
• The stock encoder assignments need to include the Color Selection attribute.
• The fixture editor no longer notifies NEO that the library and show need to be reloaded until 

the fixture editor is closed. If it is detected that NEO is running the following message will 
be displayed when clicking on the "Save" button..."NEO show running! Modifications to 
fixtures have been saved but will not be applied to the current running system until the 
fixture editor is closed."

• The Fixture Control GUI and Encoders do not sync.
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• On VL4000 Spot, Control when depressing idle - this is still at 3% and does not allow the 
command functions to execute.

Version 3 Build 30:
• There are refresh issues on the color mixing encoder screens. I have increased some time-

outs and think this is behaving much better.
• Record Group Metro DB - The changed/selected switch. Should say On = Record Changed / 

Off = Record Selected
• When a VL1100 AI ERS and a VL1100 TSD ERS patched, auto created palette pages aren't 

populating correctly.
• I've patched a VL1100 AI ERS and no encoder screens are populated. Paging works but 

encoders do not respond.
• Also reproduced and fixed the problem of double paging the encoder screens. 
• On a VL1100, when I go to Color, it's showing me both the generic mapping as well as the 

fixture specific mapping. If it sees fixture specific mapping, then the generic should not 
appear. 

• VL1100 TSD ERS - Shutter Rotate changed live appropriate but the reported DMX value on 
the encoder screen remains constant at 225. 

• Changing attribute family pages is acting like a double press and switching to that page plus 
advancing to the next page. I've checked and I'm getting 2 messages appropriately (down/
up).

• Auto Palettes puts gobos in the color palette and do not work when selected. This is now 
working properly but none of the Gobos palettes (shortcuts) work when depressed

• Tabs that select each attribute only work sometimes. They disassociate with the HW after a 
few presses of each tab. Work done in this area.

Version 3 Build 29:
• Framing rotation bug fixed

Version 3 Build 28: 
• VL1100 TSD issue resolved - Gobo Rotation only goes to STOP from one direction of 

encoder rotation, not both.
• VL2500 Spot issues resolved

a. Color wheel - where it will not go past 93% to get to color wheel rotate CCW. 
b. Same note as above for Static Gobo.
c. Same note as above for Rotating Gobo.
d. Iris - operation is inverted.

• VL3015 Spot issue resolved - Color wheel will not go past 93%.
• VL3500Q issues resolved. 

a. On the Color Wheel, have the screen show the ½ colors rather than the left color / 
white box / right color

b. Static Gobo. Can't get past 92% so can't see some rotation.
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c. Rotating Gobo. Shows Rotation when I am doing Indexing.
d. Shutter Rotate is not smooth with encoder. Needs to be smooth 1 degree per tick.

• VL3515 Spot
a. Same color wheel problem. 93%.
b. Same static gobo problem. 92%.
c. When rotating the Rotating Gobo, the Ind/Rot stays in Ind display mode. Never 

goes to the Rotate display mode.
d. Same shutter rotation issue.

• VL4000 Spot
a. Color Wheel 1 - doesn't go past 73%.
b. Hard to find STOPPED on gobo rot/ind.
c. Prism rotate is not working right. Cannot change from 0 to 255*.

Note:  * This is because there is attribute items in the list so its indexing between 2 items. Change
from a generic attribute to a rotation attribute. 

d. Same problem with Anim Wheel 1.
e. Same problem with Anim Wheel 2.
f. Description not appearing on encoder screens. It will now automatically reduce the 

font size until it fits. 
g. Shutter Rotate snaps and does not provide rotational control.

• After a save in the fixture library editor the console crashed.
• After getting out of the fixture library - going into patch none of the fixtures shows up in the 

bottom right hand corner of the screen until a full software restart is performed.
• Auto Palettes puts gobos in the color palette and do not work when selected.
• Targets on the shutter manipulation have been doubled in size.
• Tabs that select each attribute only work sometimes. They disassociate with the HW after a 

few presses of each tab
• When going back to a fixture - for example, a fixture previously worked on - REL REL and 

then come back to the fixture the HW is in the last attribute state that it was but the SW 
screen goes back to position.

• Gobo only goes to 88% on HW and 92% on SW.
• Diffusion encoder does not work but does when accessed through the touch screen.
• This is because the diffusion attribute has an item list (like a gobo/color wheel). So the 

encoder is indexing between each item. 

Version 3 Build 27:
• Console encoder and GUI att family tabs need to work bi-directionally.
• Encoders are not following the Fixture Control tabs to change attribute pages.
• On wheeled attributes, each encoder tick advanced each gobo/color.
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• Ind/Rot encoder wheel improvements.
• The Live Display button should have (F2) on the second line.
• Shortcut page, editing text, "Section Header".
• Right click Shortcut - in the options list - text errors edited.

Version 3 Build 25: 
• Changes made to the generic fixture display when you select multiple types of fixtures so 

that only the attribute that are available in the selected fixtures appear.
• Fixed advantage DMX issue 
• [RELEASE] + [COLOR] does not work. 
• Live Display Button - should say F2
• In Patch. The first column says Channel. Change to Fixture.
• In Patch, after you type in a ML, say VL3000, the up/down arrows will move but ENTER 

needs to select it. 
• Appearances - change all colour to color

Version 3 Build 23
• When you do a leading channel list park [1] [PARK] it doesn't place this on the CL. change 

to… 
a. [Fixture List][PARK][ENTER] - Parks at current level.
b. [Fixture List][@][Level][PARK][ENTER]
c. [Fixture List][PARK][DIMMER][ENTER] - parks dimmer at current level.
d. [Fixture List][PARK][DIMMER][@][Level][ENTER]
e. Change Syntax to...[Fixture List] @ dmx [Level] PARK DIMMER

• Options>Open User Guide - change to Open NEO Manual.
• Registration page - update information.
• "Channel Display (F2)". This should be called the "Live Display".
• On screen "Execute" button should say "Enter".
• Channel Groups Display. Behavior column - spelling error.
• Park>Un-park selected channels. Please change channels to fixtures.
• Un-park all channels. Please change channels to fixtures.
• On the Release pulldown, I'm not seeing that "Release current control" is working. 
• On the Release pulldown, I'm not seeing that "Release current control for selected fixtures" 

is working.
• "Release all channel group control" doesn't seem to be working.
• This should be "release submaster control" - changed.
• "Reset cue playback on DBO". What does this do?
• Legacy of when that button was called "DBO/Clear". I have renamed it to say "Reset cue 

playback on release". 
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• Selected Fixture Report > Behaviour column. Spelling error.
• Record Group pulldown > "Add selected channels to group (dimmer only)" change to "Add 

selected fixtures to Group (Intensity only).
• Record Cue pulldown > "Record active channels to cue" change channel to fixture.
• Same for all 4 other listings here.
• Record selected channels to multiple cues. (change channels to fixtures)
• Record FX> "Add active channels to simple chase step". Please change to fixtures.
• Record FX> "Add selected channels…" same here.
• When creating these chases, step time should default to a value. I recommend 1 sec.
• Also fixed a bug introduced with the new metro dialogs that prevented the last chase selected 

being populated each time. 
• When you create a "simple RGB/CMY color cycle, the DB has all attribute families preset. 

Should not have any present really as this only deals with color. 
• Record FX > "Create a simple colour wheel chase from selected fixtures". Spelling here.
• Also when you get to the dialogue box. Color spelling.
• When the same dialogue box shows up, it has all of the attribute families present. Should not 

have any present really as this only deals with color.
• The Create Palette Chase dialogue box has not been converted to a metro style box or at 

lease something with the same color scheme.
• GM button settings: Please add "Disabled" as the first option.
• Patch: When I type in the fixture box and I get a list of fixture options (several fixture 

models) , I can't click on the bottom fixture option.

Version 3 Build 22
• Swap Universe dialogue box needs higher contrast on text color.
• Patch: Options>Reset Patch - Visualizer (spelling)
• Same for Clear Patch.
• Copy Patch dialogue box needs higher contrast on text color.
• In Copy Patch box, change DMX Channel Offset to DMX Output Offset.

Version 3 Build 11
• Added button to the console debug window to display the ROM data.
• Fixed "Show Click" check box.
• Fixed fan speed and desk lamp values not being applied on startup
• Added the ability to Park/Unpark the dimmers for a channel. Syntax:- 1/5 park dimmer
• Dimmer @ {enter} now working
• Fixed controls in the fixture control panel not aligning themselves correctly when the panel 

is resized.

Version 3 Build 10
• Added option if a show file cannot be opened to copy it to the default show folder.
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• Fixed column position and size information not being saved in the cue list window.
• Fixed fan and desk lamps not being set to previous settings on startup.
• Fixed changing the fixture rotation in the layout view. It was also adjusting zoom.
• Fixed layouts changing position when changing tabs.
• Fixed earliest marking not working in Hybrid mode for channels that have never been active.
• Channel list in any channel list view (Groups, Cue List Detail, and Palette screens) should 

support THRU in the display. For example, 1/10 is displayed as 1,2,3,4,5,6,7,8,9,10.
• Full Tracking / Hybrid Tracking switch should be a bit faster.
• "Earliest" marking not working at start of cue list.
• Fixture Control side bar no longer shows NOT USED parameters from fixture library.
• Magic Sheet view - the rotate box is zooming and not rotating.
• View>Show Palette Info. Turning it off was not working in Classic View.

Version 3 Build 7
• DMX board registration is being temperamental. Fixes implemented. 
• Fixed bug where setting the dynamic color defaults to 255 on a 8bit fixture would result in 

the defaults shown (control window) as being 1.
• Fixed bug highlighted by the PLFRESNEL "Preset color selection" control. The default was 

set to 0 but the DMX spin edit would show the mid point (dmx 2). 
• Fixed bug whereby if you have a gobo selected and then change the mode (indexed -> 

rotation for example) the gobo would change but the DMX value would remain unchanged.
• Fixed bug where changing the DMX value in the Indexed rotation control would always 

result in positive values for the real world rotation. You could not change the DMX control 
and get numbers below 0.

• Fixed various oddities of the continuous rotation controls. Using the VL1100 as the 
reference. Note that the Low and High values are reversed for the CW and CCW rotation. 
The interpretation of this is as follows...

• The low (RPM) value is what speed the gobo is rotating when the DMX in the Start value.
• The high (RPM) value is what speed the gobo is rotating when the DMX is in the End value.
• For the VL1100 this means that when CW rotation is at DMX 0 is at its maximum speed of 

36 RPM. When the CW rotation is at DMX 127 is at its slowest speed of 1 RPM.

Version 3 Build 4 
• Added latest fixture library from Cresit.
• Changes to the fixture loading system to improve performance.
• Added "EDIT" command to set the cue description from the command line as per the quick 

start guide.
• Included the latest quick start guide into the build.
• Update process should restart NEO systems.
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Version 2.13 Build 565
• A/B Cross fader settings: PB Master + Crossfade: When I set the A/B faders to this setting 

and bring the B fader up and down it stays in the same cue but flashes the levels on the 
channels to zero.

• PB Master + Disabled: When I set the A/B faders to this settings and if I bring down the A 
fader it will flash the channels while I am fading. For example I have 3 cues. First cue is 
lights to full, second is lights to 0 and third is lights back to full. While lowing the A fader it 
will snap the levels to zero and then back to full when it reach zero

• Cue List Split Crossfade: Implemented. 
• With the submaster effect, if you put it onto a playback, you could play the submaster but 

you can't stop it with the pause button.
• Blind Mode: Encoders not assigning properly.
• Patch: If I try to change the quantity number in the available fixtures window in the patch 

screen with the number pad on the command tile it types it into the command line for the 
patch window. 

• Roll next build to v3 as a release candidate.

• Patch: Dimmer Phase column can't use console keypad, only keyboard. Please check all 
columns for console keypad access.

• CUE 3.8 FOLLOW 10 ENTER fails. Point cue error.
• Encoder paging…When I go from the Beam page to the Color page and then go back to the 

Beam page, it changes from Beam Page 1 to Beam Page 2. When going from one family's 
page to another, it should return to the same page.

Version 2.13 Build 561 
• Patch window opening improvements.
• Quantity number in the available fixture window in the patch screen now works from 

command line. 
• "Open a split view of channels". No other option except ML view is working.
• Help opens the Guide. Close does not close out Adobe Acrobat Reader.

Contact Information
For assistance, please contact Strand Lighting / Selecon technical support at 1.800.4.STRAND or
1.214.647.7880.
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Appendix A

NEO Console OS Software Installation
To install or update NEO Console software, follow these simple instructions…
Step 1. Download the upgrade file (file name: Neo_Setup_3_0_43.exe) from the Strand 

Lighting website (www.strandlighting.com).
Step 2. Copy the software file onto a USB key.
Step 3. Plug the USB key into the console.
Step 4. On the console, open the Control Panel (More > Control Panel).

Step 5. Go into the Maintenance environment and select “Update NEO Software”. The updater 
will look for the latest version of the software both on the hard drive first and then any 
USB key. Confirm that it is the right version. If not, then copy the correct version onto 
the hard drive before proceeding.
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Step 6. On the console, the User Account Control dialogue box will appear.
Step 7. Confirm the program name is the correct version of software and click "Yes".
Step 8. The NEO software installation screen will appear. Click "Next" and follow all prompts 

to install the software.

Step 9. The console will need to reboot to complete the installation.

Note:  If you have not done so already, be sure to register to receive updates and product
information notifications. Click here to go to the NEO Console OS Sign Up Page.

Have questions? Need assistance?
Contact Strand Lighting Customer Service at: 1-800-4STRAND (North America) or 1-214-647-
7880 (international).
04 AUGUST 2014 BULLETIN NO. SLTB-055A

http://www.strandlighting.com/index.php?src=forms&ref=NEO_ConsoleOS_Users&submenu=0

	Introduction
	NEO Console Software Version 3 Build 43
	Version 3 Build 43 Release Summary
	Version 3 Build 43:
	Version 3 Build 42:
	Version 3 Build 40:
	Version 3 Build 39:
	Version 3 Build 38:
	a. Once connected to a remote system you will see a small down pointing arrow in the top right of the window. This is how you access options like full screen etc.
	b. At the moment the remote viewing server is defaulted off. You need to turn it on in the system properties in the same place as the telnet settings.

	Version 3 Build 36:
	Version 3 Build 35:
	Version 3 Build 32:
	Version 3 Build 30:
	Version 3 Build 29:
	Version 3 Build 28:
	a. Color wheel - where it will not go past 93% to get to color wheel rotate CCW.
	b. Same note as above for Static Gobo.
	c. Same note as above for Rotating Gobo.
	d. Iris - operation is inverted.
	a. On the Color Wheel, have the screen show the º colors rather than the left color / white box / right color
	b. Static Gobo. Can't get past 92% so can't see some rotation.
	c. Rotating Gobo. Shows Rotation when I am doing Indexing.
	d. Shutter Rotate is not smooth with encoder. Needs to be smooth 1 degree per tick.
	a. Same color wheel problem. 93%.
	b. Same static gobo problem. 92%.
	c. When rotating the Rotating Gobo, the Ind/Rot stays in Ind display mode. Never goes to the Rotate display mode.
	d. Same shutter rotation issue.
	a. Color Wheel 1 - doesn't go past 73%.
	b. Hard to find STOPPED on gobo rot/ind.
	c. Prism rotate is not working right. Cannot change from 0 to 255*.
	d. Same problem with Anim Wheel 1.
	e. Same problem with Anim Wheel 2.
	f. Description not appearing on encoder screens. It will now automatically reduce the font size until it fits.
	g. Shutter Rotate snaps and does not provide rotational control.

	Version 3 Build 27:
	Version 3 Build 25:
	Version 3 Build 23
	a. [Fixture List][PARK][ENTER] - Parks at current level.
	b. [Fixture List][@][Level][PARK][ENTER]
	c. [Fixture List][PARK][DIMMER][ENTER] - parks dimmer at current level.
	d. [Fixture List][PARK][DIMMER][@][Level][ENTER]
	e. Change Syntax to...[Fixture List] @ dmx [Level] PARK DIMMER

	Version 3 Build 22
	Version 3 Build 11
	Version 3 Build 10
	Version 3 Build 7
	Version 3 Build 4
	Version 2.13 Build 565
	Version 2.13 Build 561

	Contact Information

	Appendix A
	NEO Console OS Software Installation
	To install or update NEO Console software, follow these simple instructions…
	Step 1. Download the upgrade file (file name: Neo_Setup_3_0_43.exe) from the Strand Lighting website (www.strandlighting.com).
	Step 2. Copy the software file onto a USB key.
	Step 3. Plug the USB key into the console.
	Step 4. On the console, open the Control Panel (More > Control Panel).
	Step 5. Go into the Maintenance environment and select “Update NEO Software”. The updater will look for the latest version of th...
	Step 6. On the console, the User Account Control dialogue box will appear.
	Step 7. Confirm the program name is the correct version of software and click "Yes".
	Step 8. The NEO software installation screen will appear. Click "Next" and follow all prompts to install the software.
	Step 9. The console will need to reboot to complete the installation.
	Have questions? Need assistance?



